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1.1

Introduction

1.2

Safeguard Secure PDF Viewer enables you to view protected PDF files that have been
published in .PDC format on your iOS device.

Safeguard Viewer is a standalone application that controls what you can do with protected PDF
files (for example how long you can view them for, whether you can print them, etc.). These
document controls are set by the publisher of the document and cannot be altered by yourself.

Pre-requisites

1.3

1. Safeguard Viewer supports iOS 9.1 and above

2. The Viewer will not run on devices that have been jailbroken.

Getting Started

The document owner (publisher) will have sent you an email with details of how to install the
Viewer and register (activate) your license.
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iPad = 05:29 87% M

<0 ~ P B W &«
Locklizard Licensing o
To: sarah.hartnell@locklizard.com Details

Viewing Locklizard Protected PDF Files
Today at 05:24

Welcome to Locklizard protected files service

Locklizard has authorized you to use their protected PDF files.

Select your operating system below and follow the instructions on that page to install the Viewer,
activate your license, and view protected files.

Operating System

® Windows
® Mac
® i0S
® Android

[%ﬁ Your license

To view documents from Locklizard you must activate your license:
Sarah Hartnell License

NOTE: Your license file may also be supplied as an attachment to this email (.llv and .zip files).

= Protected Files

Document licenses and controls are set by Locklizard. You must contact support@locklizard.com if
you have any questions about them.

Diagram 1: Viewer Registration Email

W —

%= NOTE: License File

If you do not receive this email, or your license file has not been sent to you by other means then

contact the publisher. You cannot view Locklizard Secure PDF Files without first activating your
license.
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1.4 Installation

1. Make sure your Operating system has installed all the latest updates.

2. Install the PDCViewer ipa app by downloading it from the Apple App Store. Then press the
Install button.

3. Once the application has installed a new app icon, PDCViewer, will be displayed on the
Home screen.

PDCViewer
Diagram 2: PDC Viewer App icon

1.5  Registration (license activation)

These instructions assume you have been emailed a link to a license (.llv file) or have been sent

it by email.

For other methods of getting files onto your device see Ways of adding documents/licenses to

Safeguard Viewer.

1.5.1 Registering licenses automatically

1. Click on the link to the license file (.llv file).

In i0S 12.x and below, this will load it into the Licenses section of the Safeguard Viewer
library and automatically register it.
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In i0S 13.x and above you will be asked to Download the file.

Do you want to download “Sarah_Hartnell.llv"?

Download

Select to Download this to Apple’s Downloads Manager. This is the blue folder icon i
on your Home page.

22:25 Wed 8 Apr

= 99% )
4 Downloads Select
Q, Search
— o
= C:%
[ ]
Sarah_Hartnell.llv Secured_PDF.pdc

Today at 22:24 3 Apr 2020 at 19:23
590 es 308 KB

7 items, 3.67 GB available on iCloud

-
Recents Il Browse

T
Open Download Manager, and select the license file. An upload icon u

will then appear
under the battery level indicator.
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22:26 Wed 8 Apr = 99% mmm

Done := Sarah_Hartnell (5 of 7) [T_]

Sarah_Hartnell
PDF Viewer License - 590 bytes

awc.-...

Notes Chrome Copy to More
PDCViewer

B

@

Copy
Add People o)
Add Tags S
Edit Actions...
Sarah_
PDF Vie\
590

Select this and then choose the ‘Copy to PDCViewer’ option.

This will copy the license to the Safeguard Viewer library and automatically register it.
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2. A message is displayed confirming successful registration.

Registration successful

Thank you. You have successfully

registered for accessing protected

documents created by Locklizard.
Support email address :
support@locklizard.com

OK

Diagram 3: Registration successful message

@ IMPORTANT NOTE: If this message is NOT displayed then see Registering licenses
manually below.

LA

% NOTE: License Activation

Automatic license registration is enabled by default.

You can turn this option off from the Settings menu > Auto Register Licenses.

1.5.2 Registering licenses manually

If a license does not automatically register for some reason, e.g.

e no network connection
e invalid or expired license, etc.
e uploaded via Wi-fi (auto registration is not supported in Wi-fi upload mode)

then you can manually register a license at any time.

To do this, go to the Licenses section of the Safeguard Viewer Library (select the Licenses
icon at the bottom of the screen as shown in the image below):
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Safari =

05:30 87% >
o) Safeguard Viewer i
Q

Demo_User.llv
== 28 Jun 2017, 05:29, LockLizard

ey

Ea 3

Documents Licenses

Diagram 4: Safeguard Viewer Library — Licenses section

3. Tap onthe license (.llv file).

4. A message is displayed confirming successful registration.

Registration successful

Thank you. You have successfully

registered for accessing protected

documents created by Locklizard.
Support email address :
support@locklizard.com

OK

Diagram 5: Registration successful message

5. The license is greyed out to show it has been activated (registered).

iPad & 05:25 87% )
0 Safeguard Viewer ¢4
Q
v

Diagram 6: Activated license
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1.6  Opening protected documents

These instructions assume you have been emailed a link to a PDC file or have been sent it by
email. For other methods of getting files onto your device see Ways of adding

documents/licenses to Safeguard Viewer.

1. Thisis the same process as registering licenses. Click on the link to the PDC file and then
select ‘Open in PDCViewer’.

This will load it into the Documents section of the Safeguard Viewer library (shown below).

Safari = 05:34 86% -
0, Safeguard Viewer [
Q

3 Locklizard_Secure_PDF_Viewer v26.pdc
28 Jun 2017, 05:34, 1.66 MB

% | Safeguard-Overview.pdc
28 Jun 2017, 05:34, 222.67 KB

“ ' Secured_PDF.pdc
28 Jun 2017, 04:15, 296.60 KB

[ForeY
Ea 23]
—0
Documents Licenses

Diagram 7: Safeguard Viewer Library — Documents

2. Click on the .pdc document to open it.

The welcome screen that is displayed can be turned off in the Settings menu.

Welcome to Locklizard Safeguard

Before you can start viewing secure PDF documents you must first register your license with your

publisher. You must be online to the Internet during the registration process because it updates the
registration control service in real-time. (Swipe this message if you want to read more)

Diagram 8: Welcome Message
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99% .

QDD RBE

21/44 Chapter 2: Viewing Protected PDF Files |

To view a protected PDF file (PDC file), double-click on it in Windows File
Explorer.

Organize~  TJOpen v Bum  Newfolder

——— Name Date modied Type Size

I Desitop 1 Encyclopedia-Britannica 2010-740 pdc
18 Downloads ] 25530-The-Book-2013-729.pdc
. Recent Places “H PDF.pdc
K Sync ] nitro-pro-8-user- guide-en-509.pdc e 1,719 KB
|7 oxFoTRO0s9-507.pdc 24/07/20141895__ Secure POF file 1680 KB
4 Libraries 3 NONBA - Newark to Harby leaflet-506.pdc  24/07/2014 1806 Secure POF file 469 KB

Diagram 14: Windows File Explorer

The protected PDF file is decrypted and displayed in the Safeguard Viewer. As
an example, you might see something like this:

2 tosaard : ) [BSer=-—)
] File View Document Help Tl
2 @ |@ @ . DWW @@ = = - e @@ € Lockdizard

vor e n.te ot v e s

Diagram 15: Viewer with p PDF
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Diagram 9: Opened document

LA

% =) NOTE: License Activation

If you try and open a document before you have registered (activated your license) the following
message will be displayed “You need to activate the license sent to you by the Publisher of the
document before you can view it.” Refer to Registration (license activation) above.
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1.7  Safeguard Viewer Toolbar

The Toolbar is displayed when you open a document.

Q@ @B K =

Diagram 10: Viewer Toolbar

e To hide the Toolbar tap on the document.
e To reveal the Toolbar tap on the document again.
e The page number and number of pages 21/44 is displayed at the top left of the

document when the toolbar is visible.

1.7.1 Menu Options

The following options are available:

1.7.1.1 Close

E(] closes the document
1.7.1.2 Search

search for text

contents

Diagram 11: Searching for text

e Select . to clear the search entry

e Use E to search forwards and E to search backwards
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e To exit search select E or tap anywhere on the document

1.7.1.3 Rotation Lock

Co) lock the rotation of the document. The icon changes to a locked status when
rotation lock is active.

1.7.1.4 Document Info

view info about the document and contact the document owner (publisher)

1.7.1.5 Bookmark

add and display custom bookmarks

e To add a bookmark select
e Toremove a bookmark swipe left on it and select the Delete option
e Click on an entry to take you to a bookmark you have previously added

e To exit bookmarks tap anywhere on the document

Page 29

Diagram 12: Custom bookmarks
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1.7.1.6 Highlight

E Highlight text and images

Mark an area on a page for later review with a rectangle box, freehand selection, or
straight line.

2.2.6 Viewing multiple pages (book format)

If you want to view pages side by side (just like in a book) then select the
Page Layout > Facing option from the View menu.

You can adjust the document display size until you see the pages fully on the
screen.

2.2.7 Menu bar display

If you have unchecked the view menu bar option and the toolbar option and
would like the menu bar to re-appear then press the escape key (ESC) on
your keyboard.

2.2.8 Full screen mode
)

The combination keys Ctrl+L can be used to switch between full screen mode
and normal mode.

This option is also available from the View menu and by pressing the L]
but k bar.

1. Printing
Whilst in full screen mode,
dialog (but only if printi

trl+P can be used to display the print
has been allowed).

2. Searching for text
Ctrl+F can be used to display the find (search) dialog.

3. Zooming in & out of a document
You can use the + and — buttons on the numeric keypad section of
your keyboard to zoom in and out of a document.

Safeguard Windows Viewer v2.6 - Revision 1.46 ©2014 Locklizard Ltd Page | 26 of 44
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Dermo User of Demo Company, demo@democompany.com

D T ¢ iocument has been vie

Diagram 13: Highlighted document
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Tap on the highlight button to enter highlight mode. This displays the highlight toolbar:

Diagram 14: Highlight toolbar

freehand style highlight

rectangle highlight (default)

underline highlight

save highlights

clear all highlights on the current page

clear ALL highlights in this document

close the toolbar

(il

“=) noTEs:
e Highlights are only available in Vertical scroll mode
e Your previously selected highlight style will be remembered
e Screen rotation is locked whilst in highlight mode
o The thumbnail page scroller is hidden whilst in highlight mode

o If you uninstall Safeguard Viewer then all highlights will be lost
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1.7.1.7 Table of Contents

: display the table of contents

e Select ~ toexpand or close a level

e To exit the table of contents tap anywhere on the document

Chapter 1: Installation & Registrat | >

Chapter 2: Viewing Protected PDF | >

2.1 Firewall / anti-spyware message...

2.2 Viewer controls | >

2.2.1 Searching for text

2.2.2 Page up [ down controls

Diagram 15: Table of contents with expanding sections

LA

% NOTE: Table of Contents toolbar icon

This icon is only displayed in the toolbar if a document has a Table of Contents.

1.7.2 Page Scroller

When the toolbar is displayed a page scroller is shown at the bottom of the
document enabling you to quickly navigate to a page.

You can turn this feature off from the Settings menu > View Settings > Thumbnail
Page Scroller > Never display, or choose to display it all the time.

Diagram 16: Page thumbnail scroller
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1.8  Safeguard Viewer Library

The Safeguard Viewer library is displayed every time you select the PDCViewer app icon.

Any .pdc or .llv files you upload to the iPad are stored in the Safeguard Viewer library.
Documents (.pdc files) are stored in the Documents section and Licenses (.llv files) in the
Licenses section.

If you press down on a filename then a menu will appear enabling you to delete, rename, open
files, and show document info.

Safari = 05:36 86% W
102 Safeguard Viewer iz
Q

Locklizard_Secure_PDF_Viewer_v26.pdc
28 Jun 2017, 05:34, 1.66 MB

Safeguard-Overview.pdc
28 Jun 2017, 05:34, 222.67 KB

gy, )

What would you like to do with this
document?

Delete

Open

Rename

Show Info

Cancel

3
A7

»

Diagram 17: Viewer Library — Documents section
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1.8.1 Searching for files

Use the search facility at the top of the library window.

Safari = 05:36 86% -’
10 Safeguard Viewer i
Q

Diagram 18: Search facility

Your search entry is automatically filtered as you type.

-

% NOTE: Search and Folder View Mode

The search facility is NOT available in folder view mode.

1.8.2 Folders

If the option ‘Show Folders’ is on (activated from the Safeguard Viewer Settings menu) then
a folder view will be displayed instead of a list view of all your documents.

£ Safeguard Viewer i
/
— ngr?;‘clw, 05:38
— fgffgw, 05:38
Inbox

&= 25 Jun 2017, 05:34
Diagram 19: Folder view

The folder ‘Inbox’ is a specific folder created by the system to store/transfer pdc/llv files
from third-party apps (email, drop box etc.). When you open a pdc/llv files from another
app, the system transfers the file to the Inbox folder and then launches Safeguard Viewer.
The Inbox folder cannot be renamed. If you delete the Inbox folder and open a pdc/llv file
from a third party app, the Inbox folder is created again and the file is stored there.
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1.8.2.1

1.8.2.2

1.8.2.3

A
\5— NOTE: iTunes

iTunes cannot share/download/upload into specific folders.

Files uploaded via iTunes will always be uploaded to the root folder, and those moved into a
different folder cannot be accessed with iTunes.

Adding folders

4
»
To add a new folder, select the E@ button at the top right of the library. The settings

button in the left corner will change to ‘ . Select this button to add a new folder in
the current location.

Moving files into folders

A
£
To move files or folders, select the &/ button at the top right of the library. Select the
. s
files or folders to move, select the ¥ button from the bottom left toolbar, and then

select the destination folder from the pop-up window.

Renaming files and folders

To rename a file/folder, press down on a file/folder name and choose Rename from the

pop-up menu. The following dialog is then displayed where you can enter the new
folder name.

r ~

Rename
Enter the file name:

‘ Safeguard|

Cancel Ok
A y

Diagram 20: Folder rename
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1.8.2.4 Displaying document information

Press down on the filename and then select Show Info from the pop-up menu to display
the controls that have been applied to a document.

Locklizard_Secure_PDF_Viewer v26

Document ID: 15971
Server: https://www.locklizard-evals.com/enterprise4/
Publisher: LockLizard
Title: LockLizard_Secure_PDF_Viewer_v26
Print: yes (all)
Print: unlimited.
Clipboard apps: not allowed
Views: unlimited
Thin client env.: not allowed
Macintosh use: yes
View Watermark: custom text.
Print Watermark: custom text.
Display settings: page view: continuous. page size: actual size. default page: 1.
Date: 1-9-2015 (mm-dd-yyyy)
Writer: v4.0.29.833

Diagram 21: Document Info

1.8.2.5 Searching for files within folders

To search for documents in the library you have to toggle back to file view since the
search option is NOT available in folder view mode.

1.8.2.6 Deleting files and folders

o Deleting individual files & folders

Press down on the filename and then select Delete from the pop-up menu.

Alternatively, swipe the file/folder left or right to reveal the Delete button.

o Deleting multiple/all files & folders
A
Select the button at the top right of the library.

You can then select multiple files/folders individually or select all of them by using

]
the = button (bottom right of library) and then selecting the . button to
delete them.
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Safari = 05:39 85% W
[ ] Safeguard Viewer i
/
0 H Folder1
28 Jun 2017, 05:38
- Folder2
28 Jun 2017, 05:38
;  Inbox
LY 2017, 05:34
LI EER
Diagram 22: Selecting a folder for deletion
' ==
%= noTE: Deleting Folders
Deleting a folder will delete all files within that folder.
safari & 05:43 84% >
[} Safeguard Viewer &
/Inbox
oy -
o E Locklizard_Secure_PDF_Viewer v26.pdc
@ 28 Jun 2017, 05:42, 1.66 MB
) 3" gafeguard-Overview.pdc
@ 28 Jun 2017, 05:34, 222.67 KB
Y =" Secured_PDF.pdc
@ 28 Jun 2017, 05:42, 296.60 KB
Are you sure you want to remove these
files?
Yes
No
| R =ER

Diagram 23: Selecting all files for deletion
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1.9 Safeguard Viewer Settings menu

From the Safeguard Viewer Settings menu you can change Safeguard Viewer program settings.

To open Settings select the @ button in the top left of the Safeguard Viewer library.

iPad = 13:03 98%

Settings Done
DOCUMENTS & LICENSES

Sort By Date

Mark Used License

O
Auto Register Licenses O
| @)

Show Document Cover

Double Tap To Open

Remember Last Page O

Keep Screen On

(.

Show Folders

-

View Settings

INTERNET CONNECTION

Use only Wi-Fi

-

Wi-Fi Upload

KEYSTORE

Remove Keystore

This deletes your Safeguard Viewer Keystore. You will not be able to view protected documents unless you register your
license(s) again.

SUPPORT

Welcome Tips At Startup
License Agreement
Online Product Manual
Crash Report

About

Diagram 24: Safeguard Viewer settings menu
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The following options are ON by default:

e Remember last page
e Mark used license

e Auto register license

e Show document cover

1.9.1.1 Sort by date

Files are sorted by the date when they were created/uploaded or just how the system
retrieves them. If this option is off then sorting is done by the system which is a little
faster (usually this is alphabetically but it is not guaranteed).

1.9.1.2 Mark used license

Licenses you have activated (registered) will be greyed out and have a check mark next
to their name.

1.9.1.3 Auto register licenses

License files are automatically registered when they are loaded into the Viewer library.
Auto registration occurs when an llv file arrives in the Viewer library — this could be via
an email or web page link, or shared/opened from other app (like iTunes, dropbox, etc.).
Licenses uploaded via Wi-Fi will NOT automatically register and therefore require
manual registration.

If a license has been successfully registered a message is displayed confirming
registration. If a license cannot be automatically registered (i.e. no wi-fi connection,
expired or invalid license, etc.), no error is displayed and you will have to register the
license(s) manually.

1.9.1.4 Show document cover
After a document is successfully opened, its first page will be used as cover (just like
thumbnails) in the documents list, so you can distinguish between documents quicker.

1.9.1.5 Double tap to open

To open a document or register a license you must use double tap, not just a single
tap/selection.
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1.9.1.6

1.9.1.7

1.9.1.8

1.9.1.9

Remember last page

Remembers the last page viewed. Next time you open the document it will open at that

page.

Keep screen on

When reading a document the screen will not standby/dim and turn off, it will stay on so
you can read without any interventions.

Show folders

Allows you to create and manage folders in which you can store documents, rather than

just showing them as a single list.

NOTE: If this feature is turned on then the library search facility is not available.

View settings

Configure how you want to scroll through the document (horizontally or vertically),
show single or double page view, the thumbnail page scroller, and the text quality.

< Settings Document View Settings

PAGE STYLE

Vertical scroll
Horizontal scroll
Side-by-side view

Single page view

Select how document pages will be displayed. Side-by-side view will force landscape display. Creating document
highlights is supported only on Vertical scroll

THUMBNAIL PAGE SCROLLER

Display with toolbar

Always display

Never display

Select how the thumbnail page scroller should display.
RENDER QUALITY

Low quality

Normal quality

High quality

It may be best not to select High Quality on older hardware since it will have a detrimental effect on viewing documents.

Diagram 25: Document View Settings
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1.9.1.10

1.9.1.11

e Page Style
Select how you want to scroll through the document. Note that:

o Highlights are only available in Vertical scroll mode.
o Single and side by side view only support horizontal scrolling.

e  Thumbnail page scroller
This displays the page scroller at the bottom of a document. The default setting
is to display when the toolbar is visible.

e Render Quality
If you are viewing a large document on older devices with limited memory (i.e.
1GB of DRAM is only available on the iPad mini 3 and below) and the document
is very slow or crashes regularly, then choose a lower render quality in order to
save on memory. It does not matter how much flash memory your device has as
Safeguard Viewer uses DRAM for displaying protected PDF documents.

Use only Wi-Fi

Instructs the Viewer to only connect when a Wi-Fi internet connection is available (so it
doesn't use mobile data via a SIM to consume more expensive bandwidth).

When this option is turned on and a connection is required but no Wi-Fi is available, a
message is displayed if a mobile Internet connection is available.

If the option is turned off, the Viewer will connect to the server regardless of the
available connection type (Wi-Fi or mobile).
Wi-Fi upload

Here you configure your Wi-Fi upload settings so you can upload PDC files and licenses
to your device via your local Wi-Fi network.

Click on this to show the Wi-Fi Upload Settings dialog where you can enter the Port
number and your username and password.
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{ Settings Wi-Fi Upload Settings

Upload Port: 8080

AUTHENTICATION

Ask For Password
Username:

Password:

Turn on "Ask For Password" and LockLizard Safeguard Viewer will ask for the above credentials when you connect
wirelessly for documents upload.

Diagram 26: Wi-Fi Upload Settings

e Ask for Password
Turn on 'Ask For Password' if you Safeguard Viewer to request a username and
password before you can upload files. This is useful if you are using an
unsecured/shared Wi-Fi network.

1.9.1.12 Remove Keystore

Deletes the Viewer keystore.

You may want to use this feature if the document publisher tells you they have extended
your account or document expiry date but this information is not being picked up by the
Viewer.

e If you use this option you will have to register again to access documents. Any
licenses you have uploaded into the Viewer library will be marked as unused -
you have to tap on each license in order to register it again.

e Any bookmarks you have created will be lost.

e Any last pages remembered (Settings menu > Remember Last Page) will be lost,
so documents will now open again at page 1.

1.9.1.13 Welcome tips at startup

A welcome popup with swipe support is displayed when the Viewer loads displaying
information on how the Viewer works and what you need to do to get started.
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1.9.1.14 License Agreement

Displays the Locklizard license agreement.

1.9.1.15 Online product manual

Displays this manual.

1.9.1.16 Crash Report

Displays crash reports. These can be emailed to Locklizard support.

1.9.1.17 About

Displays the app name, version number, and your iOS version number.
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1.10 Ways of adding documents/licenses to Safeguard Viewer

These instructions for items 3-5 assume you already have protected PDF files (.pdc files) and
licenses (.llv files) on your computer or LAN.

If 'Auto Register Licenses' is on (Settings Menu > Auto Register Licenses) then any .llv files you
upload will be automatically registered — except for those uploaded via Wi-Fi.

1.10.1 Email

If license files (.Ilv files) and PDC files have been sent as attachments by email, then clicking
on these will:

e IniOS 12.x and below, it will automatically load them into the Safeguard Viewer
library

e IniOS 13.x and above, you will be asked to Download the file to Apple’s Download
Manager. In Download Manager, select the license file and then the upload icon

ﬁl. Then select the option ‘Copy to PDCViewer’.

= 99% (amm)
Sarah_Hartnell (5 of 7) ﬂ“]
= Sarah_Hartnell
PDF Viewer License - 590 bytes
; ( X X J
Notes Chrome Copy to More
PDCViewer

Diagram 27: Opening a license file

This will load the license file into the Licenses section of the Safeguard Viewer
library and automatically register it.
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1.10.1.1 Gmail instructions

Click on the license file link and then choose your Browser to open it.

Open with

Chrome
Google, Inc.

Google
Google, Inc.

Ask me which app to use every time C

Diagram 28: Clicking on a license file link in Gmail

Then select the upload icon |-T_-| and select the ‘Copy to PDCViewer’ option:
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Done

@) AirDrop

AN

Suggestions

" Notes

Chrome
Edge
Drive
Gmail

a Dropbox

n Copy to PDCViewer

Diagram 29: Opening a license file in Safeguard Viewer
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1.10.2 Web Site Link

1.10.2.1

Clicking on a link to an llv or PDC file on a web page will:

e IniOS 12.x and below, it will automatically load them into the Safeguard Viewer
library

e IniOS 13.x and above, you will be asked to Download the file to Apple’s Download
Manager. In Download Manager, select the license file and then the upload
icon. Then select the option ‘Copy to PDCViewer’. This will load the license file into
the Licenses section of the Safeguard Viewer library and automatically register it.

% NOTE: Support web browsers

All popular browsers (Safari, Firefox, Chrome, Opera) are supported. Microsoft Edge is NOT
supported.

Direct links

You can also create specialized links that will download the license and documents
directly to the Safeguard iOS Viewer, bypassing the use of the iOS Downloads Manager.

To do this, simply have the download links for the licenses and/or documents (on your
distribution platform) in this format:

e Licenses: pdcviewer://www.domain.com/license.llv
e Documents: pdcviewer://www.domain.com/document.pdc

After a user has installed the Safeguard iOS Viewer and they tap on one of these links in
Safari, the Safeguard iOS Viewer will launch and start downloading the respective file.

1.10.3 iTunes

With your device connected to your computer, load iTunes, navigate to Apps > File Sharing
and select “PDCViewer”. Click on the Add button to upload PDC files and licenses to the
Safeguard Library.

To see the files, launch PDCViewer on your iOS device (by selecting the PDCViewer app
icon), or refresh the lists by selecting the “pull to refresh option”.
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1.10.4 Wi-Fi upload

1.10.5

1.10.6

1.10.6.1

You can upload PDC files and licenses to your device via your local Wi-Fi network.

i »
In the Safeguard Viewer Library, tap the top-right icon & to enter edit mode and then
—_

L)
selectthe °H icon to begin the Wi-Fi upload process.

A message is displayed asking you to connect with your computer browser to a local
address (like http://192.164.0.13:8080). On your computer, open your browser and
navigate to that address. NOTE: your computer must be connected to the same Wi-Fi
network as your iOS device. You will see a web page with upload options for files and
licenses - select them from your computer and click upload, and repeat the operation until
all of your files are uploaded.

Click on “Finish Wi-Fi Upload” in the Safeguard Viewer when you are done to finish the
upload process.

NAS

You can browse for PDC (documents) or LLV (license) files on your NAS device just like any
other file using the File Explorer application provided with your NAS. Select a PDC or LLV
file, right-click on it, then select "Copy to PDCViewer" to add it to the Safeguard Library.

If the File Explorer application provided with your NAS does not work (for example, the PDC
Viewer opens but nothing appears in the window) then use FE File Explorer or a similar
third party application.

Cloud file storage (i.e. Dropbox, Microsoft SkyDrive, etc.)

Install a cloud file storage system on your computer and your iOS device and follow the
instructions to synchronize files between devices.

Dropbox instructions

One way of transferring files from a PC or Mac computer to the iPad is to use an
application known as Dropbox. This creates a ‘cloud’ file storage system that allows you
to upload files, movies, pictures and so on, that you can share across your account or
also with other people. So you can use it to make PDC files downloaded onto your
PC/Mac available to upload to your iPad.
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https://itunes.apple.com/us/app/fe-file-explorer-file-manager/id510282524

To do this you need to download the Dropbox application on the iPad, and that means
setting up an account with Dropbox as well as having an Apple ID. Dropbox may be
found in the Apple app store, or at www.dropbox.com.

Once you have installed Dropbox on your iPad, you must then download the Dropbox
application onto either the PC or Mac, and log on to the account that you created on the
iPad. That links the accounts together. As soon as you have done that, the Dropbox app
will open a virtual folder where you can drop files to be synchronised between the PC
and the iPad. So from the PC end you can drop files into the Dropbox folder and they
will become available to the iPad device dynamically, and at the iPad end, files, pictures
and so on that are on the iPad are made available for download into the PC.

NoSIM = 5:46 PM 65 % .

{ Recents  Locklizard Q4 000 Q4 [l oo

Q, Search this Folder
Locklizard_license.llv

526 bytes - modified 30 June 2017

/3d4910£8d10916242 Export

§£225531db46bff18fbal
Secured_PDC.pdc ~-END PDC Viewer LICEI
221 KB - modified 5 hours ago AI Rename

best
FILES 122t
50£7 AirDrop. Tap to turn on Wi-Fi and Bluetooth to share
agit with AirDrop.
123¢
e58¢
2861
Secured_PDC.pdc i
221 KB - modified 5 hours ago
. @
2 Files @
@
=]
‘Add to Notes Reminders Mail Twitter
@ X)) L XX}
Copy Link More
Open In... td
bc8st
FILES 122t
50£7 AirDrop. Tap to turn on Wi-Fi and Bluetooth to share
with AirDrop.

; ; S 287t
. Lockhzard_h;ense.llv © B

e58¢
2861
Secured_PDC.pdc S

221 KB - modified 5 hours ago

2 Files

Copy to
PDCViewer

Copy to Drive More

Diagram 30: Safeguard files in Dropbox
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www.dropbox.com

1.10.6.2

License Files (.llv): Select the .llv file in Dropbox. This will display the file contents

(which you can ignore). Click on the ﬁ EXport putton and then select ‘Openin’ and
then 'Copy to PDCViewer'. The license will then be added to the Licenses section of the
Safeguard Viewer library where you can click on it to register (activate) your license.
This process is shown in the diagram above.

Secure PDF Files (.pdc): Select the .pdc file in Dropbox. Click on the ﬁ Export
button and then select ‘Open in” and then 'Copy to PDCViewer'. The PDC document will
then be added to the Documents section of the Safeguard Viewer library where you can
click on it to openiit.

Drive instructions

Select the license file or document and then the Open In menu option.

16:58 Wed 15 Apr =35%e
; o
X iOS_NEW.Ilv &t Share s
B~ ¢ Add to Starred

@ Make available offline
C\-') Link sharing off

r[:] Copy link

— Send a copy

‘ & Open in

Rename

Details & activity

4
I Makea copy
®
O

Report abuse

Diagram 31: Importing a license file in Drive
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Then select the More menu options and swipe across to select ‘Copy to PDCViewer’:

16:58 Wed 15 Apr =35%8

X iOS_NEW.Ilv -

iOS_NEW
PDF Viewer License - 539 bytes

™M 9l -
Q0O

0B

Gmail Copy to More
PDCViewer

Save to Files (]
Save to Dropbox 33
Edit Actions...

Diagram 32: Opening the license file with Safeguard Viewer
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1.11 Document controls
Document controls are set by the publisher (document owner) and cannot be changed.
To view controls applied to a document press on a PDC file in the Safeguard library and select
Show Info.
1.12 De-installation
1. Press onthe PDCViewer application until it starts wobbling.
2. Pressthe X on the left hand corner of the icon.
De-installation removes the PDC Viewer, the Document and License library, and the Viewer
keystore.
1.13 Upgrading the Viewer
When you do an iOS Software Update, Apple will inform you about any updates available.
1.14 Troubleshooting

For specific issues please visit our support knowledgebase.

Search for the keyword in an error message rather than a string of text. For any items not
covered here please consult the publisher of the document.
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